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Installing and Registering

Installing and Running Solitaire for Windows
Registering   Solitaire for Windows  



Game Information

Selecting a Game
Saving & Opening
Scoring
Pausing a Game
Auto Finish
Alternative Rules



Tour Information

Selecting a Tour
Saving & Opening
Championship Tour
Grand Tour
Golf Tour
Custom Tour



Preferences

Card Drag, Alternatives
Duplicate Play
Timed Play
Scoring
Alternative Rules



Miscellaneous Information

Auto Finish
Selecting a Deck and Board
Hot Keys
Saving & Opening



Pausing a Game

To pause the game, select the minimizing icon (down arrow icon) at the top right of the application 
window.    This will display the Windows Desk Top and the Solitaire for Windows icon.

To restart the game, without any loss of time, select the Solitaire for Windows icon and Restore.



Registering Solitaire for Windows

If you register Solitaire for Windows you will receive:

1) Up-to-date information on new games and graphics for Solitaire for Windows and notification of 
updates as they become available.

2) Discount coupons offering savings on your purchase of other Interplay products.

3) Information of other outstanding Interplay Production programs like:

- Battle Chess
- Omar Sharif on Bridge

To register Solitaire for Windows, use the registration rorm enclosed with your program, or call/write:

Interplay Productions
17922 Fitch Avenue
Irvine, CA 92714
(714) 553-6678
FAX: (714) 252-2820

or call: 800/969-GAME

End



Installing and Running Solitaire for Windows

Solitaire for Windows' is easy to Install on your hard disk.

1) Put the Solitaire for Windows disk in Drive A or Drive B.

2) From the Program Manager File Menu, choose Run....

3) Type A:\INSTALL or B:\INSTALL into the space provided.

4) Press the OK button.

To Run Solitaire for Windows':

1) From the Program Manager Games group.

2) Select the installed Solitaire for Windows application icon.

3) Press the Enter key.

End



Solitaire for Windows Game Rules

Select the desired game.

Beleaguered Castle
Calculation
Forty Thieves
Four Corners
Golf
Klondike
La Nivernaise
Poker Solitaire
Pyramid
Scorpion
Spider
Three Shuffles & a Draw



Scoring

There are two forms of keeping track of the score in Solitaire for Windows:

Traditional - designed to track number of cards to the Foundation.
Challenge    - designed to increase the strategy, and therefore the skill needed to make consistently 

high scores.

The scores for each game may be viewed in one of the Score screens.

Score Screens
Championship High Scores

Additionally, two of the games have Bonus Points related to winning before using up the allowed number 
of deals and/or draws.



Spider

Played with two decks of cards, Spider is similar to Scorpion.    The goal of Spider is to move all the 
cards to the Foundation.

Spider begins with 4 piles of 5 cards and 6 piles of 4 cards (total of 10 piles) dealt face down to the 
Tableau.    To each of the 10 piles is added an available face-up card.    The remaining 50 cards make up 
the Stock.

In Spider only complete sets of 13 cards (Ace to King, all the same suit) can be moved to the Foundation. 
The entire run of 13 cards must to be built within the Tableau before it can be moved to the Foundation.

With one exception, only fully exposed cards are available for play to the Foundation.    Any available 
card may be placed on a fully exposed card in descending order, regardless of suit.    This means that a 
9 of clubs may be placed on a 10 of spades.

The exception to the above rule lets an available run of any length be moved, as a set, and placed in 
descending order on a fully exposed card in another column.    For example, the 9, 8 and 7 of diamonds 
can be moved together and placed on a 10 of any suit.    Runs may be divided, with the "lower" section of 
the run being placed on an available card of any suit, as long as it's in descending order.

A face-down card becomes available when the exposed cards on it are moved to another column When 
this happens, the card is turned over and becomes available for play.    When a vacant column occurs, it 
can be filled with any available card or run.

When play is stalled by a lack of moves, a new row of 10 cards is dealt from the Stock across the bottom 
of the Tableau.    New rows may not be built until vacant columns have been filled.

As 13-card runs are made, they can be moved to any empty space in the Foundation.

The game is over when there are no cards available, or when remaining moves do not improve the hand. 
It is won when all the cards have been moved to the Foundation.

Scoring

The player gets points for every run created, and additional points whenever a card is added to the run.    
Points are taken away whenever a card is subtracted from a run.    In Challenge scoring, bonus points are 
awarded whenever a 13-card run is moved to the Foundation, The bonus points increase as 13-card runs 
are moved to the foundation consecutively.

Strategy

Successful play depends on exposing the face-down cards as soon as possible and creating empty 
columns to store the face cards which are played last.

It is usually desirable to move a complete run to the Foundation as soon as possible.    In the Challenge 
scoring mode, higher scores will be made if complete runs are moved to the Foundation consecutively.

End



Golf

The goal of Golf is to remove all of the cards from the board.    The removed cards are placed in the 
Waste     Pile   to the right of the Stock.

The Tableau consists of 35 cards (seven across and 5 down).    Only fully     exposed   cards are available 
for play, including the top card of the Waste Pile.

Cards are moved from the Tableau to the Waste Pile in either ascending or descending order 
(regardless of suit).

Play Example

If a 4 is showing as the top card of the Waste Pile, the only possible play is a 5 or 3 from the Tableau.    A 
5 or 3 must be fully exposed on the Tableau to be played.    If a 5 or 3 is not available, the next card must 
be dealt from the Stock on to the 4.

If a 5 has been played on the 4, the next move would be 4 or 6 from the Tableau .    If the 6 is played, the 
next move would be either a 5 or 7 from the Tableau.    When no more cards can be played from the 
Tableau, another card must be dealt from the Stock.    Remember, only a 2 may be played on an Ace.    
Play ends after a King; a card must be dealt from the Stock to begin play again.    Queens cannot be 
played on Kings (see, Alternative Rule for Golf for exception).

The game is over when no more cards can be played from the Tableau to the Waste Pile and there are no 
more cards in the Stock.

The game is won when all of the cards have been removed from the Tableau and all remaining cards in 
the Stock have been moved to the Waste Pile.

Strategy

Try to get the longest runs possible by planning ahead.    Try to expose cards that have the best chance 
of being used as the run continues.

End



Alternative Rule for Golf

King to Queen    --    A Queen may be played on a King to allow play to continue.    This rule change 
increases the chance for a win; is not available for the Championship     Tour  .

See also:

Alternative     Rules   for instructions on implementing an alternative rule.



Four Corners

Named from the board layout, where the four Foundation piles are at the "four corners" of the 5-card 
Tableau.    The goal of Four Corners is to move all of the cards to the Foundation piles.

Four Corners has a Stock (screen far left), Waste Pile (to the right of the Stock), Foundation (the four 
corners of the Tableau), and a Tableau (the 5 cards in the center of the Tableau).    The Foundation card 
located in the upper left "corner" is the first card of the Foundation for that suit (like cards of the other suit 
will start the other three Foundation piles as they come up in play).

In Four Corners, Aces and Kings are neither high nor low, but rather part of the sequence that must be 
played to complete a Foundation pile.

Cards are turned from the Stock one at a time, and then played to:

1) The Foundation piles in ascending order by suit.
2) To the Tableau in an empty space or on another card in descending order regardless of suit.
3) To the Waste Pile if it cannot be played, or if the player chooses not to play it yet.

The exposed card from the Waste Pile is available for play.

Cards in the Tableau can be played to a Foundation pile, or can be moved within the Tableau in 
descending order, regardless of suit.    For example, if a 9 of hearts and an 8 of spades is exposed in the 
Tableau, the 8 may be placed onto the 9.

Play Example

If 4 of clubs is in the upper left corner, then the other beginning Foundation cards are the 4 of diamonds, 
the 4 of spades, and the 4 of hearts.    These cards will be played, put into an empty Foundation space, as 
they are exposed during play.

In the Foundation, the next card that can be played onto the 4 of clubs is the 5 of clubs, then the 6 of 
clubs, and so forth.    The last card to be played on the clubs Foundation pile will be the 3.

The game ends when it is not possible to move additional cards to the Foundation piles, and there are no 
more cards in the Stock.    A win occurs when all Foundation piles contain all 13 cards for their respective 
suit.

Auto Finish is available in this game.

Strategy

In Four Corners, it is important to set up the Tableau with cards that will be needed in the short-term, and 
bury in the Waste Pile cards that may not be needed until later in the game.    Sometimes it is important to 
leave cards in the Waste Pile, even when there are empty spaces in the Tableau.

End



Pyramid

The goal of Pyramid is to clear all of the cards from the Tableau, Stock and Waste Pile.

28 cards are dealt into a pyramid-shaped Tableau.    With one exception (see below) only fully exposed 
cards are available for play.    The cards are cleared from the screen by pairing (the King stands alone) 
cards that total 13 points.    Cards are given these point values:

- Ace 1 point
- 2 2 points
- 3 3 points
- 4 4 points
- 5 5 points
- 6 6 points
- 7 7 points
- 8 8 points
- 9 9 points
- 10 10 points
- Jack 11 points
- Queen 12 points
- King 13 points

All cards (except the King) must be removed in pairs, the Queen and Ace are removed together, as are 
the Jack and 2, the 10 and 3, the 9 and 4, the 8 and 5, and the 7 and 6.

Most of the time both cards must be available to make a play.    However, when a card is the only one 
covering its pair, the two cards may be removed.

Cards in the Tableau may be paired with other Tableau cards, with cards in the Stock or in the Waste 
Pile.    Cards are dealt to the Waste Pile from the Stock when there are no other plays available, or at the 
discretion of the player.

The game is over when there are no more cards in the Stock, and there are no more exposed pairs 
available.    The game has been won, when all cards have been paired.

Strategy

In Pyramid it is important to plan for the cards that will be needed as the game progresses.    Since the 
entire Tableau is visible, it is possible to see what cards will be needed when the top of the pyramid 
becomes exposed--this knowledge can make a difference in how cards are played early in the game.

End



Klondike

This is the best known of all solitaire games.    The goal of Klondike is to move all of the cards to the 
Foundation,in ascending order by suit.

28 cards are dealt into a Tableau of 7 columns.    The first column contains 1 card, the second 2 cards, 
the third 3 cards, etc.    When the game begins most cards are face down, except for one fully exposed 
card in each column.    Cards must be available to be played to the Tableau or the Foundation (see 
Alternative Rules for Klondike).

Cards are played on each other within the Tableau in descending order, alternating red and black (the 
suit does not matter).    When a column becomes vacant, only a King may be moved into the space.    The 
face-down cards are exposed as they become available during play.

Cards are played to the Foundation from the Tableau or the Waste Pile in ascending order, by suit.

During play, at the player's discretion, cards are dealt from the Stock to the Waste Pile in groups of 3 (see 
Alternative Rules for Klondike).    Only the fully exposed card is available for play.    When the Stock is 
exhausted the cards in the Waste Pile are returned to the Stock to be redealt.

The game is over when no more plays can be made to the Foundation.    The game is won when all cards 
have been moved to the Foundation.

Auto Finish is available in this game.

Strategy

The strategy for Klondike changes dramatically, depending on whether the Traditional or Challenge 
scoring method is being used.    With Traditional scoring, cards should be placed to the Foundation in a 
way that best assures success through even advancement among all suit.    With Challenge scoring, the 
more cards held in the Tableau, to be placed consecutively to the Foundation, the higher the score.    In 
Challenge scoring the best possible game is when all 52 cards are placed in one consecutive play to the 
Foundation without intervening plays between Stock, Waste Pile or Tableau.

As it is sometimes advantageous to hold back cards from placement in the Foundation, it is also 
sometimes important to hold back cards in the Waste Pile, even though they could be placed to the 
Tableau or Foundation.    In fact, discretionary playing of the Waste Pile can significantly improve the 
chances for success.

End



Alternative Rules for Klondike

Single Card Turn    --    The Stock is turned 1 card at a time (instead of 3 cards at a time).    This change 
greatly increases the chances for success (almost assures a win).    This rule is not available for the 
Championship Tour.

Visible Card (Parital Column) Move    --    Visible cards in the Tableau may be played on fully exposed 
cards (according to the rules of card placement above).    When this play is made, all of the cards in the 
column below the chosen card are moved along with it.    This change increases the chances of success. 
This rule is not available in the Championship Tour.

Vegas Rules    --    When Vegas Rules are implemented the method for both scoring and play changes. 
Scoring is handled as a gamble win/loss with the player paying $52 for the deck and getting back $5 for 
every card moved to the foundation.    In regard to play, if 3 cards are deal from the stock at a time, 3 
turns of the stock are allowed.    If 1 card is dealt from the stock at a time (see above), then the stock can 
only be turned once.

See also:

Alternative Rules for instructions on implementing an alternative rule.



Scorpion

Scorpion is unusual in that it doesn't have a Stock, Waste Pile, or Foundation.    All of the cards are 
dealt to the Tableau at the beginning of the game, except for 3 cards which make up the "merci".    The 
"merci" can be played at any time, at the discretion of the player.

The goal is to arrange the cards in descending order by suit.

Only fully exposed cards can be played upon, by descending cards of the same suit.

Play Example

The 4 of hearts, if visible, can be played on a fully exposed 5 of hearts.    When the 4 of hearts is moved 
to the 5 of hearts, all cards below it in the Tableau move too.    No cards may be played on a Ace.    A 
face-down card becomes available (is turned over) when it becomes exposed.

The game is over when no cards can be played, or when the plays that can be made do not improve the 
final solution.    It is won when all of the cards are placed in descending order from King to Ace, by suit.

Strategy

The basic strategy is to watch carefully, to be sure that every possible move is made.    In regard to the 
dealing of the merci, the best timing seems to be when there are no more moves available in the Tableau.

End



Calculation

The goal of Calculation is to move all of the cards to the Foundation in a prescribed numerical pattern 
without regard to suit.

The game begins with a Stock in the upper left of four Foundation locations already dealt with a 1, 2, 3, 
and 4.    Beneath the Foundation are locations of four Waste Pile columns.

The Foundation is dealt with one card in each of four piles.    The Foundation piles are built up by 1's in 
the first pile, 2's in the second pile, 3's in the third pile and 4's in the fourth pile.

The order of each Foundation pile is as follows:

1's 2's 3's 4's

Ace 2 3 4
2 4 6 8
3 6 9 Q
4 8 Q 3
5 10 2 7
6 Q 5 J
7 Ace 8 2
8 3 J 6
9 5 Ace 10

10 7 4 Ace
J 9 7 5
Q J 10 9
K K K K

The Stock is exposed one card at a time.    If the card is not playable to one of the Foundation piles, it 
must be placed in any of the Waste Pile columns.    Only fully exposed cards can be played from the 
Waste Pile to the Foundation, and cards may not be moved within the Waste Pile.

The game ends when the Stock is empty, and no more cards may be played to the Foundation.    It is won 
when all of the cards have been moved to the Foundation.

Auto Finish is available in this game.

Strategy

Learn how to place cards in the Waste Pile so that the best chance possible exists for playing them to the 
Foundation.    Become very familiar with the order of cards that is needed in each of the Foundation piles, 
so that earlier cards do not become hopelessly buried under cards that will not be needed until later.    It is 
very important that cards do not become buried under Kings (the last cards to be played).

End



Forty Thieves

This is a 2-deck solitaire game in which the goal is to move all of the cards to the Foundation.

When the game begins there 10 columns of 4-face-up cards each (there are no face-down cards).    The 
remaining 64 cards make up the Stock.    The Waste Pile is to the right of the Stock (see Alternative 
Rules for Forty Thieves).

In the Tableau, fully exposed cards are played in descending order by suit only.    Runs may be moved 
as a group when available (see Alternative Rules for Forty Thieves).    When a column becomes 
vacant, any available card or run can be moved into it.

Cards are played to the Foundation from the Tableau, the Stock, or the Waste Pile in ascending order, by 
suit, (Ace to King).    Available runs of the same suit, playable to the Foundation in ascending order, can 
be moved to the Foundation as a group.

During play, at the player's discretion, cards are exposed on the Stock, with the previously exposed Stock 
card being dealt to the Waste Pile, 1 at a time.    Both the newly turned Stock card and the fully exposed 
Waste Pile card are available for play.    The Stock is only reviewed once.

The game is over when the Stock is empty and no more plays can be made to the or Foundation.    The 
game is won when all cards have been moved to the Foundation.

Auto Finish is available in this game.

Strategy

The strategy for Forty Thieves changes dramatically, depending on whether the Traditional or Challenge 
scoring method is being used.    With Traditional scoring cards should be moved to the Foundation as 
needed to assure a win, while with the Challenge method of scoring, the more cards are placed 
consecutively to the Foundation without intervening moves the higher the score.

End



Alternative Rules for Forty Thieves

Aces Up  --    (The Lucas variation)    All of the Aces are placed in the Foundation at the start of play.    
This improves the chances for success.    This rule is not included in the Championship Tour.

Allow Runs to be Moved    --    Allows the movement of runs as a unit; any length allowed.    This makes 
the game easier to win.    This rule is included in the Championship Tour.

See also:

Alternative Rules for instructions on implementing an alternative rule.



La Nivernaise

This is a 2-deck solitaire game with an unusual Tableau and Foundation.    The goal of La Nivernaise is 
to move all of the cards to the 8 Foundation piles.

The four cards on either side of the Foundation piles are part of the Tableau and are called the Flanks.    
This area is used as a holding area for cards, and is not affected by the redeals.    At the bottom left of the 
screen is the Stock, and to the right is 6 columns of 4 face-up cards each, called the Line, which make 
up the balance of the Tableau.    When the game begins, the Ace of spades is always in the upper left 
Flank.

During play, one Ace of each suit is played to the top Foundation row, while one King of each suit is 
played to the bottom Foundation row.    Cards are then played to the Foundation in ascending rank (Ace 
to King) in the top row. and in descending rank (King to Ace) in the bottom row.

Any of the Flank cards can be played to the Foundation.    Only available Line cards can be played to the 
Foundation or used to fill empty spaces in the Flanks.

An interesting additional play feature in La Nivernaise is the ability to "reverse" the cards in the 
Foundation.    For example, if the top "club" Foundation has a 7 of clubs, and the bottom "club" 
Foundation has an 8 of clubs, the option exists for the player to move the lower Foundation cards to the 
upper Foundation and visa versa (see Alternative Rule for La Nivernaise).

Whenever a Line column becomes vacant, 4 more overlapping cards are dealt.    And, when it is no longer 
possible to play to the Flanks or Foundation, 4 more face-up cards may be dealt to each column of the 
Line.    Finally, if no cards remain to be dealt and no moves can be made, the Line cards are picked up, 
moved to the Stock (without reshuffling) and dealt to the Line again, as column of 4 cards.    Two redeals 
are allowed.

The game is over when there are no redeals left and no cards can be moved to the Flanks or the 
Foundation.    The game is won when all of the cards have been moved to the Foundation.

Bonus Points

Bonus points are paid (Challenge scoring only) when the game is won in less than the given number of 
redeals.    The bonus points are:

1) No Redeals 1000 points
2) One Redeal 500 points

Strategy

The critical strategy here is the proper use of the Flanks.    It is a gamble not to keep one space open on 
the Flanks at all times.    Additionally, the use of the reverse can free up cards to be placed on the 
Foundation.

End



Alternative Rule for La Nivernaise

No Reverse    --    Does not allow the reverse option.    Makes the game more difficult to win; is included in 
the Championship Tour

See also:

Alternative Rules for instructions on implementing a alternative rule.



Poker Solitaire

The goal of Poker Solitaire is to score the highest possible points.    In this game the deck is shuffled, and 
then play begins with all the cards in the Stock and no cards being placed in the Tableau.

Each card in the Stock is played to the Tableau as it becomes exposed.    The exposed card can be 
placed in any empty position, but once it is placed it cannot be moved.    The object is to make the best 
possible Poker hands in each of the 5 rows and 5 columns.

The scoring is based on the Poker hand and its rank in the game of Poker.    This means that a Royal 
Flush is the best possible hand and scores highest, while a pair is the lowest possible and scores the 
least.    Using Traditional scoring, the hands and score for each is:

Royal Flush 100
Straight Flush 75
4 of a Kind 50
Full House 25
Flush 20
Straight 15
3 of a Kind 10
2 Pair 5
1 Pair 2

For Challenge scoring, the hands and score for each is:

Royal Flush 1000
Straight Flush 750
4 of a Kind 500
Full House 250
Flush 200
Straight 150
3 of a Kind 100
2 Pair 50
1 Pair 20

Strategy

For consistently high scores, it is best to go for Flushes.    While a Flush is usually harder to get than a 
Straight or 3 of a Kind, iin Poker Solitaire a Flush is actually easier to get than those other hands.

End



Beleaguered Castle

This game has the Foundation in the middle and the Tableau as 8 rows, 4 to each side of the 
Foundation area.    The goal is to move all of the cards to the Foundation.

Available cards are played on fully exposed cards in the Tableau in descending order regardless of 
suit.      In addition, runs of the same suit, that make up the last cards of a row, may be moved as a group 
to be placed on a card of a different or same suit in another row, in descending order (see Alternative 
Rules for Beleaguered Castle).    When a row becomes vacant, any available card or run can be moved 
into it.

Cards are played to the Foundation from the Tableau in ascending order, by suit, beginning with the Ace 
(see Alternative Rules for Beleaguered Castle).

The game is over when no more plays can be made to the Foundation.    The game is won when all cards 
have been moved to the Foundation.

Auto Finish is available in this game.

Strategy

The strategy for Beleaguered Castle changes dramatically, depending on whether the Traditional or 
Challenge scoring method is being used.    While with Traditional scoring it is important to play cards to 
the Foundation in a timely fashion, trying to keep the Foundation piles even, so that cards may be more 
easily moved around in the Tableau.    With the Challenge method of scoring, the more cards held back, to 
be placed consecutively to the Foundation, the higher the score.

End



Alternative Rules for Beleaguered Castle

Aces Up    --    All of the Aces are dealt to the Foundation at the start of play.    Improves the chances for 
success; is not included in the Championship Tour.

Allow Runs to be Moved    --    Allows the movement of runs as a unit; any length allowed.    This makes 
the game easier to win.    This rule is included in the Championship Tour.

See also:

Alternative Rules for instructions on implementing a alternative rule.



Three Shuffles & a Draw

The goal of Three Shuffles and a Draw is to move all the cards to the Foundation.

The cards are dealt into a Tableau with 16 stacks of 3 cards each with the Aces already moved to the 
Foundation.    When the game begins all 52 cards are face up, with 16 (the fully exposed card of each 
stack) available.

Available cards can be played to both the Foundation in ascending order by suit, or onto fully exposed 
cards in the Tableau in descending order by suit.

During play, empty stacks are lost to play.    After all possible plays have been made to the Foundation, 
the cards left in the Tableau are reshuffled and dealt out again in stacks of 3 each.    The number of 
stacks dealt will depend on the number of cards remaining in the Tableau.    Two reshuffles are permitted.

In addition, the player gets one Draw at any time in the game, where any buried card may be chosen to 
be played to the Foundation or the Tableau.    The Draw provides an opportunity to make a critical card 
available for play.

The game is over after the final shuffle and the Draw    has been taken, when no further moves can be 
made to the Foundation.    The game is won when all of the cards have been played to the Foundation.

Bonus Points

In Three Shuffles and a Draw, bonus points are paid, Challenge scoring only, when the game is won in 
less than the given number of shuffle, and/or without using the Draw.    The bonus points are:

- One Shuffle -- No Draw 2000 points
- One Shuffle & a Draw 1000 points
- Two Shuffle -- No Draw 750 points
- Two Shuffle & a Draw 500 points
- Three Shuffle -- No Draw 250 points

Auto Finish is available in this game.

Strategy

Try to expose cards that are unavailable at the beginning of the game as soon as possible, without 
blocking cards that will be needed later on.    It is tempting to use the Draw when that will result in a good 
play.    However, it is usually best to use the Draw when it will result in a win.

End



Glossary

ASCENDING FACE-UP RUN
AVAILABLE FLUSH SEQUENCE
BLOCKED FOUNDATION SHUFFLE
BURIED FOUR OF A KIND STOCK
COLUMN FULL HOUSE STRAIGHT
CURRENT GAME FULLY EXPOSED STRAIGHT FLUSH
DEAL PAIR SUIT
DESCENDING RANK TABLEAU
DISCARD REDEAL THREE OF A KIND
DRAW ROW TWO PAIR
FACE-DOWN ROYAL FLUSH WASTE PILE

End



Alternative Rules

In Solitaire for Windows the "rules" are enforced by the program.    One or two rules in five of the games 
can be changed at the player's discretion.

To change a rule(s) for a specific game, first make sure that the desired game has been selected (Select 
Game), then:

1) Select the Options menu and open the Preferences... dialogue box.

2) Select Alternative Rules by clicking on the command button.    This will open the Alternative 
Rules dialogue box.

NOTE:    If the Alternative Rules command button is not activated, there are no alternate rules for the 
current game.

3) Click the check box to activate the desired change(s), and press the OK button.

NOTE:    Changing a rule during a game, ends the game and deals a new one.

For Alternative Rules in a specific game, select the game desired:

1) Beleaguered Castle
2) Forty Thieves
3) Golf
4) Klondike
5) La Nivernaise

End



Ascending

A sequence of cards that goes from a lower rank to higher ranking card, usually starts with the Ace and 
ends with the King.



Available

A card or run which, according to the rules of the game, may be taken and put somewhere else.    Usually 
a card is available if it stands alone or is the fully exposed one on the Waste Pile, a column or a row.    
A run is available if the bottom card is fully exposed.



Blocked

A game is "blocked" if no more moves can be made.    When a game is blocked, it may be "lost," or it may 
be possible for the player to make a special move to "unblock" the game.



Bonus Points

Bonus points are given in the Challenge scoring mode, when playing the following games:

1) La Nivernaise
2) Three Shuffles and a Draw



Buried

A card covered by another card and, therefore, not available is buried.



Challenge Scoring

Method of scoring solitaire games exclusive with Solitaire for Windows, designed to increase the strategy 
needed to make high scores.

To implement Challenge Scoring, first select Start New Game (Game menu), then:

1) Select the Options menu and open the Preferences... dialogue box.

2) Select the Challenge option button under Scoring, and press OK.

Challenge Scoring will remain in effect until the Traditional option button is selected.

NOTE:    Changing the setting during a game, ends the game and deals a new one.

In Challenge Scoring, points are awarded by consecutive cards played as follows:

1st card     5 points
2nd card 10 points
3rd card 15 points
4th card 20 points
5th card etc.

Each consecutive card has its point value increased by 5 points.

There are also bonus points given for every 10 cards played consecutively:

After 10 cards 250 points
After 20 cards 500 points
After 30 cards 750 points
After 40 cards 1000 points
After 50 cards 1000 points
After 60 cards etc.

Each additional 10 cards pays 1000 points total.

End



Championship Tour

The Championship Tour is a special tour included in Solitaire for Windows so players from all over can 
compare high scores.

The following conditions exist in the Championship Tour:

1) Solitaire games must be played consecutively.

2) Rules (including some Alternative Rules) are permenantly established for each game.

3) Timed Play is activated.

NOTE:    It is possible to pause a game while playing the Championship Tour.

To play the Championship Tour:

1) Select the Game (Tour) menu and open the Select Tour... dialogue box.

2) Select Championship Tour from the list of tours available and press OK.

The Championship Tour is loaded, with Golf ready to be played.

The following games are included in the Championship Tour, in the order shown:

1) Golf
2) Pyramid
3) Calculation
4) Four Corner  s  
5) Klondike
6) La Nivernaise
7) Three Shuffles & a Draw
8) Beleaguered Castle
9) Scorpion

10) Spider
11) Forty Thieves
12) Poker Solitaire

End



Column

A line of over lapping cards running "down" the screen.    They are spread out so all of the face-up cards 
are visible, but only the last one is fully exposed and, therefore, available.



Current Game

The game that is currently open on the playing board (screen).    Under normal circumstances the game's 
name is displayed in the title bar next to "Solitaire for Windows."    If the game is part of a Tour, its name 
will be displayed on the menu bar.

The name of the current tour is displayed in the title bar when a Tour is being played.



Deal

The act of moving a card from the Stock to the Tableau at the beginning of the game, and to the Waste 
Pile,Tableau and Foundation during the game.



Descending

A sequence of cards goes from a high ranking to a lower ranking; i.e., from 10 to 7 or Jack to 2..



Discard

To move a card to the Waste Pile.



Draw

Used In Three Shuffles & a Draw to make available a card that is buried.

To Draw a card:

1) Point the Cursor Arrow at the pile that contains the desired card.

2) Press the Right Mouse Button.

The pile is displayed as a column showing all of the cards within it.

3) Point the Cursor Arrow at the desired card.

4) Press the Left Mouse Button. 

The selected card will move to the top of the pile and play continues normally, with the Draw no longer 
available.

To cancel the Draw option:

1) Point the Cursor Arrow to any other point on the screen.

2) Press the Left Mouse Button.

The pile returns to normal, and play can resume with the Draw still available.

End



Face-down

Card dealt upside down (turned over) so that its suit and rank cannot be seen.



Face-up

Cards that are visible, dealt so that their suit and rank can be seen.    Face-up cards cannot be played on 
unless they are "available," however, under certain conditions they may be able to be played.



Flush

5 cards of the same suit, regardless of rank.



Foundation

The area of the screen where cards are placed, for the final solution of the game.



Four of a Kind

Four cards of the same rank.



Full House

Three of a Kind and a Pair in the same hand.



Fully Exposed

A card that does not have another card on top of it.    A fully exposed card is available to be played.



Hot Keys

The following features can be used from the keyboard, without accessing a menu, by pressing the 
assigned "hot keys".

When playing a game:
Hot Key

Start New Game N
Restart Current     Game R
End Current Game E
Auto Finish F
Undo U
Help Index F1

When playing a tour:
Hot Key

Restart Current Tour R
Start Next Game N
End Current Tour E
Auto Finish F
Undo U
Help Index F1

End



Pair

Two cards, usually of the same rank.    In Pyramid, two cards totaling 13 points.



Rank

Denotes the value of a card, how it relates to others.    A card may be of the same rank, of a higher rank, 
or of a lower rank than the other cards in the column, row, etc.    When cards are placed according to 
rank, they are placed in sequence.



Redeal

To move a group of cards from the Waste Pile or the Tableau, to the Stock so that they can be dealt 
(played) again.



Row

Cards lined up horizontally.



Royal Flush

A run from 10 to Ace (10, J, Q, K Ace).



Run

A sequence of 2 or more cards of the same suit.



Sequence

A group of 2 or more cards that are placed in numerical order.



Shuffle

To "shuffle" means to mix up the cards so that they are arranged in as random an order as possible.    All 
games begin with the deck in random order (shuffled).    When this action takes place more than once 
during a game, it is called "reshuffling" the cards.



Stock

This is the remainder of the deck, after the Tableau has been dealt.    The Stock is used to provide 
additional cards necessary to continue playing the game; usually by being exposed 1 or 3 cards at a time.



Straight

A sequence of 5 cards by rank, regardless of suit.



Straight Flush

A run of any five cards all of the same suit.



Suit

Cards can be of one of the following suits:    Hearts, Diamonds, Spades, and Clubs as designated by color 
and identifying symbol on each card.



Tableau

This is the initial "lay out" of cards on the screen where the action takes place.    Cards are usually placed 
in the Tableu from the Stock (sometimes from the Waste Pile) and then moved to the Foundation for the 
final solution.



Three of a Kind

3 cards of the same rank.



Timed Play

Solitaire for Windows can be played "against the clock."    This is called Timed Play.

The player is given a set amount of time to complete the game.    Whenever a move is made to the 
Foundation, additional time is added to the clock.    When "time is up" the game is over.

A Timed Play game can be paused (the clock stopped) by "minimizing" Solitaire for Windows.    You can 
Minimize the program by:

1. Clicking the Windows' Minimize (down arrow) icon at the upper right of the screen.

2. Opening the Application dialogue box (top left corner of screen) and selecting the Minimize 
option.

When you "Restore" the program from the minimized icon, the game will begin from where it was paused; 
no time will have been lost from the clock.

Each game starts with a specific amount of time on the clock:

Game Time Additional. Time

Beleaugered Castle 300 sec. 5 sec/card
Calculation 40 sec. 5 sec/card
Forty Thieves 200 sec. 5 sec/card
Four Corners 150 sec. 5 sec/card
Golf 20 sec. 1 sec/card
Klondike 150 sec. 5 sec/card
La Nivernaise 150 sec. 5 sec/card
Poker Solitaire 150 sec. none
Pyramid 40 sec. 1 sec/card
Scorpion 300 sec. none
Spider 600 sec. none
Three Shuffles... 150 sec. 5 sec/card

To activate the Timed Play mode:

1) Select the Options menu and open the Preferences... dialogue window.

2) Click the Timed Play check box to activate the option, and press OK.

The Timed Play option will remain activated until it is deactivated.

NOTE:    Changing the setting during a game, ends the game.

Timed Play is automatically activated when playing the Championship Tour.

End



Traditional Scoring

The method of scoring where one point is awarded for each card played to the Foundation, or other end 
pile.    No bonuses are paid when the Traditional scoring mode is being used.

To implement Traditional scoring, first select Start New Game (Game menu), then:

1) Select the Options menu and open the Preferences... dialogue box.

2) Select the Traditional option button under Scoring, and press OK.
  
Traditional scoring will remain in effect until Challenge scoring is selected.

NOTE:    Changing the setting during a game, ends the game and deals a new one.

End



Two Pair

Two sets of two cards, where each set is of the same rank.



Waste Pile

This stack, or pile, of cards is usually made up of the unused cards as they are played from the Stock.  
Fully exposed cards on the Waste Pile are usually available for play.    In some games the Waste Pile is 
reshuffled and dealt in continuing play.



High Score Screens

High Score screens are available for all of the games and tours in Solitaire for Windows.    The screen will 
display when the game, tour, or tournament is current.

To display the screen:

1) From the Options menu, choose the Show Scores... command.

The High Score screen for the current game will open.



Championship High Scores

The high score screen for the Championship Tour is accessible at any time.

To display this screen:

1) From the Options menu, select the Championship High Scores... command.

The High Score screen for the Championship Tour will open.

The scores listed on this screen are the best scores attained by the developers and testers of Solitaire for 
Windows.    These scores can be erased by pressing the Clear button.



Golf Tour

This is a very different tour, especially in the way that it scores.    It has been designed to "play" and score 
like a golf game.    Golf Tour consists of 9 consecutive games of Golf solitaire, and is scored in the 
tradition of a real golf game (i.e., the lower the score the better).

Each game starts with 51 points (one card is in the Waste Pile,) a point is subtracted for every card 
moved to the Waste Pile.    A perfect game is scored 0 points.    However, par is considered to be 7 points 
for each game, 63 points for the tour.

To play the Golf Tour:

1) Select the Game (Tour) menu and open the Select Tour... dialogue box.

2) Select Golf Tour from the list of tours available and press OK.

The Golf Tour is loaded, ready to be played.

End



Grand Tour

This tour is similar to the ChampionshipTour

To play the Grand Tour:

1) Select the Game (Tour) menu and open the Select Tour... dialogue box.

2) Select Grand Tour from the list of tours available and press OK.

The Grand Tour is loaded, ready to be played.

End



Auto Finish

This option, found under the Game (Tour) menu, places all "available" cards into the Foundation 
automatically, and then ends the game.

This feature is very convenient when the Tableau has been set up so a large number of cards will go to 
the Foundation consecutively.    The necessity of moving the cards to the Foundation one at a time, is 
eliminated.

To implement this feature:

1) From the Game (Tour) menu, select the Auto Finish command.

Warning! Selecting this command ends the game!

End



Card Drag, Alternatives

Solitaire for Windows has three options for moving cards around on the board:

Card Holding down on the left mouse button, and moving the mouse,    "drags" the entire card.

Outline Holding down on the left mouse button, and moving the mouse, moves an outline of the card.

Off Select the card to be moved, press the left mouse button (the card becomes highlighted), 
point at the desired new location, press the left mouse button again.

NOTE:    Changing the setting during a game, ends the game and deals a new one.

To change the current setting:

1) From the Options menu, select Preferences....    This opens the Preferences dialogue box.

2) Select the desired setting by clicking the appropriate option button.

The setting chosen will remain activated until another setting is selected.

End



Selecting a Deck and Board

Solitaire for Windows comes with 12 different card decks and 10 custom boards (not including a "solid 
color" preference with a method of choosing almost any color desired).

To access the Select Deck and Select Board options:

1) Open the Options menu and choose either the Select Deck or Select Board command.    A 
listing of the available decks (or boards) is shown.

2) Select the desired Deck or Board.    When a specific deck or board is selected, an image of it 
shows in the the dialogue box.

3) Press OK.    The selected deck or board is loaded with the game ready to be continued, or 
begun. 

New decks or boards may be selected at any time, including during the playing of a game without 
restarting the game.    Once a deck or board has been selected it will remain until a new one is choosen.

End



Duplicate Play

Duplicate Play is a feature that lets you compete with a friend to see who can play a specific game or tour 
best.

The advantage of Duplicate Play is that everytime the game is started over (Start New Game) the same 
Tableau is dealt.    In other words, the shuffle is the same each time the game is dealt.    (If you are 
familiar with "duplicate bridge," Duplicate Play uses the same basic principle).

In addition, each Duplicate game or tour has its own Score board, so that the scores of individuals can be 
easily tracked.

To activate Duplicate Play:

1) From the Options menu, select Preferences....    This opens the Preferences dialogue box.

2) Click the Duplicate Play check box to activate the option, and press OK.

The Duplicate Play option will remain activated until it is deactivated.

End



Selecting a Game

From the Game menu, you can either Start a New Game or Select Game, depending on whether you 
want to continue playing the current game, or begin playing an entirely different game.

Start a New Game Shuffles the deck and deals a new hand, but does not change to a different type 
of game.

Select Game Brings up the Select Game window.    From the list provided, choose the game 
desired, and press OK.

It is also possible to Restart Current Game or End Current Game from the Game menu.

From the Tour menu, you can choose the Select Game option to exit the Tour menu, return to the Game 
menu, and select a game to play.

End



Saving & Opening

Games, Tours and Duplicate Games & Tours may be saved for replaying at a later time or date.    In 
addition, Saved files may be shared with friends who also own Solitaire for Windows.

The current game, tour or tournament will be the one saved when this option is accessed.

To access the Saved As... option to save a specific game, tour or tournament:

1) Open the File menu and choose the Saved As... command.    The Save Game dialogue box 
opens.

2) Enter a name for the game.

NOTE:    The name entered cannot contain more than eight (8) alpha-numeric characters.    This is the 
MS-DOS standard for file names.

3) Press OK.    The game, tour, or tournament is now saved under the entered name. 

To Open a Saved Game:

1) Open the File menu and choose the Open Saved Game... command.    The Open a Saved 
Game... dialogue box opens.

2) Click On or Enter the name for the desired game.

3) Press OK.

The game, tour, or tournament is loaded, ready to play. 

End



Selecting a Tour

By accessing the Game menu, you can Select Tour to choose an existing tour and access the Tour 
menu.    From the Tour menu you can:

Start a New Tour Shuffles the deck and deals the first game of the new tour,
but does not change to a different tour.

Select Tour Brings up the Select Tour window.

From the list provided you can select a different tour or create a Custom Tour.

It is also possible to Restart Current Tour, Start Next Game, or End Current Tour from the Tour menu.

From the Tour menu, you can choose the Select Game option to exit the Tour menu, return to the Game 
menu, and select a game to play.

End



Custom Tour

This feature makes it possible for you to create a Custom Tour, suited to your personal likes and dislikes. 
In other words, if you enjoy playing Grand Tour, but don't like one of the games, you can make a tour 
here that plays only the games you like.

To create a Custom Tour:

1) Select the Tour (Game) menu and open the Select Tour... dialogue box.

2) Select Custom Tour from the Tour Selection box on the left    This will bring up the Custom Tour 
dialogue box.

The available games are listed in the Games Selection box on the left.    The Create Tour box on the 
right is either empty or has a listing of the games for the current Custom Tour.

3) Select (if any) games to be deleted from the Create Tour box, and press the Delete From Tour 
command button.

4) Select the games desired from the Games Selection box, and press the Add To Tour command 
button.

When the Custom Tour is finished,

5)  Press OK. The Custom Tour will be loaded, ready to be played.

Any number of games between 2 and 12 can make up a Custom Tour.    Specific games may be used as 
often as desired (you could have a Tour that included 12 games of Klondike).

Any Alternative Rules in effect at the time the tour is played will be enforced during the playing of the 
Tour.    It is not possible to have different versions of the same game in the same tour.

See Also:

Saving & Opening, for instructions on how to save and open Custom Tours.

End


